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Using this 
template  

The standard headings and tables in this template should be modified to meet the 
requirements of each Initial Assessment.  The sites may have diverse issues and 
constraints and problems and the standard template is therefore just a guide on 
typical requirements but flexibility is allowed to amend/ add headings as required 

 

 Hidden 
guidance  

The template contains various pieces of guidance covering content, use of tables 
etc.  The guidance is shown in blue text and can be turned ‘on’ to assist in the 
writing stages or ‘hidden’ for viewing or when printing the document.  You can 
switch between ‘hidden’ and ‘on’ and back to ‘hidden’ at any time. 

To show/hide the guidance click on the ¶ icon on the MS Word toolbar.  

If the hidden text does not disappear off the screen when the ¶ icon is clicked, go 
to:  Tools>Options>View Tab and uncheck the ‘Hidden text’ box.   

It is advisable to work with the hidden text turned on, as this helps to format new 
text and to avoid deleting the hidden text itself. 

 

Auto-
updating of 
contents 
page  

The contents page will update to reflect changed information in the main text and 
tables.  To update right click on the relevant area of the contents page, to highlight 
it, and select ‘Update Field” to access the update option. 

To enable these updating features to be created, the document contains specific 
text types and “fields”.  These are Headings 1, 2, 3 & 4; fields in the table labels 
and in the appendix labels.  When editing the document, take care to maintain 
these aspects. 

 

Inserting new 
headings  

To insert new headings in the main text go to: Format>Styles and Formatting to 
open the styles box. Insert the new headings, highlight it and click on the 
appropriate Heading level in the ‘Pick formatting to apply’ box.  Paragraph text 
can be inserted and formatted in a similar way. 

 

Inserting new 
tables  

Table labels should be added by Insert>Reference>Caption and selecting ‘Table’ 
from the drop down ‘Label’ box.  This will insert the Table title with the correct 
number and the caption can be typed in after the label.  Tables can then be cross 
referenced from the text by Insert>Reference>Cross Reference and selecting the 
appropriate reference type and caption from the drop down box and list. 

Initial assessment report  
Bradford IA Hirst Mill Saltaire 
November 2016 
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Numbering 
paragraphs  

All paragraphs should be numbered sequentially as sub-sets of the section 
number. Prompts for paragraph numbering are provided as ‘Start writing here’ 
after which pressing <return> will automatically provide the next paragraph 
number.  
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1.1  Introduction and background 

Working in partnership with the City of Bradford Metropolitan District Council, 15 locations 
within Bradford were identified to have been significantly affected by the 2015 Christmas 
Floods. These locations were subsequently grouped into five main catchment areas to be put 
forward for initial assessments through engaging with the engineering consultant CH2M Hill on 
an existing contract: 

•        Keighley & Stockbridge 

•        Bingley & Airedale 

•        Baildon & Shipley 

•        Esholt & Apperley Bridge 

•        Silsden Beck 

 

The inputs for the FCRM Partnership Funding Calculator were obtained through consultation 
with Bradford Metropolitan District Council and highlighting the properties likely to benefit from 
a potential scheme at each site location within the catchment - through assessing the EA 
Flood Zone 3 and draft 2015 Christmas Flood Outline extents (April 2016) on GIS.  

 

The objectives of the project are to assess the potential for a scheme and associated 
proposals to aid in the alleviation of flooding within the identified sites in the Bingley & Airedale 
area, through undertaking initial assessments on an existing contract with the engineering 
consultant CH2M Hill. The proposals will look to be further progressed to a detailed appraisal, 
detailed design and construction, following the assessment and selection of an appropriate 
scheme. 

 

1.1.1 Description of Location 

Saltaire is a village located in Shipley, part of the City of Bradford Metropolitan District, in West 
Yorkshire. Saltaire is located by the River Aire and the Leeds and Liverpool Canal, and is also a 
designated UNESCO World Heritage Site. 

The property at risk is an old mill converted for residential use. The building contains three 
different properties within its ground floor and is situated immediately downstream of a weir which 
contains energy dissipating boulders placed along its downstream face. 

  

1.1.2 Description of Watercourses and Geology 

The River Aire rises in the Pennine hills near Malham in the Yorkshire Dales, flowing in a south 
easterly direction until Castleford, where the river is joined by the Calder and turns eastward 
toward Airmyn. Here, the River Aire meets the River Ouse approximately 148 kilometres from its 
source.  

The River Aire catchment has been considerably modified for flood defence purposes. Flood 
embankments have been built up along much of the channel and there are several controlled 
washland (floodplain) areas in the upper reaches as well as downstream of Leeds. These act as 
both controlled and uncontrolled washlands and significantly attenuate peak flows along the river. 

The study area is low lying with little to no gradient. The Lower River Aire follows a gentle 
meandering course through a broad floodplain. 

The geology of the study area is characterised by clay, sand and silts. 
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Even if there are no detailed information about the watercourse, at the site aim of the study, is 
judged that at this stage, the information about the generic features of the river, reach a sufficient 
level of detail. 

 

1.1.3 History of Flooding 

Major historic flooding in the Aire catchment occurred in 1775, 1866 and 1946. Minor events 
include 1967, 1980, June 2000, October/November 2000, February 2002 and August 2002, July 
2007 and December 2015. Flood protection throughout the Lower Aire catchment is provided by 
flood walls, embankments and washlands.  

The gradient of the river Aire is low (approx. 1 in 35,000) and the floodplain extensive.  

1.1.4 Summary of Modelling Analysis 

In 2001, the Upper and Lower Aire Preliminary Strategic Reviews concluded that a combined 
hydrological-hydraulic model was required to better understand the flooding mechanisms in the 
catchment and to support the development of a comprehensive strategy to manage flood risk to 
communities in the floodplain. 

In 2001 Atkins were commissioned to deliver Phase 1 of the River Aire Modelling Study. Phase 1 
involved the collection of new topographic survey and hydrometric data, estimation of flows using 
the methods detailed in the Flood Estimation Handbook (FEH) and construction and calibration of 
a hydrodynamic model of the River Aire and associated floodplains. This further lead onto the 
development of a robust calibrated model, which was then used to undertake a series of design 
runs. 

The River Aire model reach was defined from Gargrave at its upstream extent, down to its 
confluence with the River Ouse downstream of Airmyn. In order to accommodate this long 
stretch, the River Aire was subdivided into the following three reaches and modelled accordingly: 

• “Upper Aire” - from upstream of Gargrave Bridge to Leeds Station Weir (FDMS reaches 
16-29) 

• “Lower Aire” - from Leeds Station Weir to Fairburn Ings (FDMS reaches 12-15) and the 
Lower Calder from Stanley Ferry to its confluence with the Aire (FDMS reaches 1-3) 

• “Tidal Aire” - from Fairburn Ings to the River Ouse at Airmyn (FDMS reaches 1- 11) 

The final three models combined to form a catchment wide one-dimensional hydrodynamic (ISIS) 
model which was deemed to effectively capture the flow attenuation within the catchment. The 1 
in 100 year fluvial and 1 in 200 year tidal design flood levels were key deliverables from this 
study, which was completed in Autumn 2004. This work formed the basis for the Upper Aire 
Flood Risk Management Strategy which aimed to define flood risk within this area and identify 
potential flood risk management options.  

The existing hydraulic model has allowed for climate change up to the year 2105 with a 30% 
increase to the hydrological inflow. However the guidance for climate change analysis has been 
updated since the Upper Aire Modelling Study and therefore these results are now outdated. 
Climate change modelled flood outlines were not considered in this initial assessment with 
analysis using present day outlines to assign flood risk bands. The model has not been calibrated 
since the work undertaken in 2002-2004 and should be updated including recent events, if the 
scheme progresses to OBC stage. 
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Downstream of the study area there are three weirs that can influence the level of the water at 
the site. Detailed modelling work on the three weirs is currently   being undertaken by the EA 
National Flood Modelling team. An initial review indicates there may be limited benefit from 
removing or lowering the weirs  

1.1.5 Drivers, Constraints, Opportunities 

Saltaire falls under the River Aire Catchment Flood Management Plan1 (CFMP), and is covered 
by sub-area 3 Worth and Aire. The designated policy for residential areas at risk is Policy Option 
5: areas of moderate to high flood risk where we can generally take further action to reduce flood 
risk. This policy will tend to be applied to those areas where the case for further action to reduce 
flood risk is most compelling. The CFMP vision is to improve the co-ordination between the 
multiple organizations that manage the various sources of risk. 

The following drivers, constraints and opportunities have been identified within the study area.  

Political Drivers  Exist?  Summary Description 

Catchment Flood Management Plan Yes River Aire CFMP 2010 

Catchment Flood Management Policy Yes 

Policy 5: Areas of moderate to high flood risk 

where we can generally take further action to 

reduce flood risk 

Economic Drivers   Exist?  Summary Description 

Enable Development Yes 

There is potential development at this site but 

is dependent on flood risk and the outcome of 

this options analysis. 

Technological Drivers  Exist?  Summary Description 

Improved Public Safety Yes Via reduced flood risk.  

Environmental Constraints  Exist?  Summary Description 

World Heritage Site Yes 

World Heritage Site lies approximately 500m 

east of the Benefits area. A full impact 

assessment should be conducted once an 

option has been selected. 

 

1.2 Problem and objectives 

 

1.2.1 Problem 
The event of the 25th to 29th December was the result of a weather front which travelled in a 
north easterly direction immediately following behind storm Eva. The front first passed over 
West Yorkshire before heading across through North Yorkshire. 

The more significant rainfall totals and rainfall return periods occurred for the peak 24 hour and 
36 hour period over the 25th and 26th December. During this time, the average monthly 
rainfall for December fell over the Pennine edge of West Yorkshire and through central North 
Yorkshire. 

                                                

 
1  https://www.gov.uk/government/publications/river-aire-catchment-flood-management-plan 
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Rainfall return periods of more than 1 in 50 years were recorded in parts of the upper Calder, 
upper Aire, and middle Wharfe catchments for the 24 hour peak totals. 

The only data available, regarding the flow in the river Aire at Branksome Drive, is from a 
gauge station located roughly 10 Km upstream of the site. At the Gauge station of Kildwick, 
was recorded a flow 163 m3/s corresponding to an 80- 100 years return period. It is possible to 
note that the return period of rainfall and flow is quite different, this is because the rainfall fell 
on already saturated ground and into rivers that were already high. 

There are three properties at risk of fluvial flooding due both to the elevation and proximity to 
the River Aire. During the Boxing Day event, all the ground floors of the properties at Hirst Mill 
were flooded from the river. 

The gardens adjacent to the property are raised above the river and are retained by a concrete 
wall. The properties themselves back on to the garden. During the Boxing Day flooding, 
residents observed water overtopping this wall by approximately 0.5m, inundating the garden 
and flooding the properties. The threshold levels of the properties are set a few centimetres 
above the level of the garden and top of wall. 

 

1.2.2 Objectives 

The objectives of this initial assessment are to assess the current condition of the site and 
evaluate the possible options for reducing flood risk at the property.  

The purpose of this report is to lay the groundwork and, where applicable, provide a business 
case for future appraisal. The report aims to achieve the following: 

• Confirm the need for a project; 

• Identify the issues and Political, Environmental, Societal, Technological, 
Legislative and Economic (PESTLE) drivers and opportunities related to the need; 

• Identify the options to address the need and problem; 

• Demonstrate that viable options exist based upon the available information; 

• Provide sufficient information to allow the packaging and optimisation of 
packages of future appraisal, design and construction packages; 

• Provide sufficient information for the appraisal scope to be prepared; 

• Make an assessment on the deliverability of the project; 

• Provide a basis/starting point for discussion with communities and partner 
organisations for use in the development of potential schemes and negotiations 
regarding funding contributions. 

 

1.3 Benefits 

In this area the primary benefit associated with a reduction in flood risk would be the reduction in 
economic damages to properties.  

Social benefits relate primarily to a reduction in stress, health effects (including risk to life) and 
loss of memorabilia for those at risk. 
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In line with guidance, an appraisal period of 100 years is assumed, over which the current 
Standard of Protection of existing assets is expected to decrease as a result of climate change. 

 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 

Table 1.1 Number of Properties at Risk (based on Dec 2015 flood) 

Property Type Flood Risk Number of 
Properties 

≥1 in 25 year (4% AEP) 

(Very Significant Risk) 
3 

<1 in 25 year (4% AEP) 

≥1 in 75 year (1.33% AEP) 
(Significant Risk) 

0 
Residential  

<1 in 75 year (1.33% AEP)  

≥1 in 200 year (0.5% AEP) 

(Moderate Risk) 

0 

≥1 in 25 year (4% AEP) 

(Very Significant Risk) 
0 

<1 in 25 year (4% AEP) 

≥1 in 75 year (1.33% AEP) 

(Significant Risk) 

0 
Non-Residential 

<1 in 75 year (1.33% AEP) 

≥1 in 200 year (0.5% AEP) 

(Moderate Risk) 

0 

Detail of the methodology used for assessing the benefits of each option is detailed in Appendix 
C. 

 

1.4 Options 

A long list of options has been compiled for the study area and is summarised in the table on the 
following page. The table shows the range of options considered and the reasoning for or against 
them being taken forward to the shortlist of options to be assessed. 
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Category Long List Option Water 
Course / 
Areas 
Affected 

Description Take Forward for 
assessment? 

Reasoning / Notes / Past Study 
Reference 

Do nothing Do nothing  All operational and 
maintenance activities cease 

Yes Required to support development of 
business case and benefit cost 
ratios. 

Do minimum Do Minimum  Continue with current 
operational and maintenance 
activities. Maintenance work 
are needed for channel and 
existing wall. 
 

Yes Represents current approach to 
asset maintenance and repair. Minor 
works to retain necessary 
performance. 

Non-structural 
(by EA) 

Improved flood warning  Enhanced flood warning to 
allow residents to prepare 
plus appropriate 
implementation of flood action 
plans 

No Not funded via the capital 
programme. 

A Flood warning system is already 
in place for the River Aire at Hirst 
Mill.   
Improving the current system would 
require further modelling which is 
beyond the scope of this study. 

Non-structural 
(by EA) 

Flood action plans  Improved direction of 
reactionary flood defence 
measure (fire crews, 
temporary pumps, etc.) 

No The study area is already within a 
Flood Warning and Flood Alert area 
operated by the Environment 
Agency. 

Property level 
protection 

Property level protection  Protection to individual 
properties via air brick covers 
and door guards. 

Yes PLP is assumed to be viable for all 
ground floor residential properties in 
the very significant risk band. 
However, the depth of flooding at 
these properties would have to be 
analysed at the next stage, as PLP 
is only suitable where the flood 
depth is less than 500mm and 
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Category Long List Option Water 
Course / 
Areas 
Affected 

Description Take Forward for 
assessment? 

Reasoning / Notes / Past Study 
Reference 

duration less than 3 days.  

Structural Earth bunds  Flood bund  No This option is not being taken 
forward in the assessment.  The 
land take in the back garden will be 
significant and make the 
construction difficult. 

Structural Flood walls  Flood walls Yes Construct a flood defence wall along 
the property boundary facing the 
river. If possible this would build on 
the existing wall and replace the 
railings in the current wall. It may 
however be necessary to replace 
the entire wall. 

Structural Temporary defences  Demountable flood walls, 
flood gates etc. 

Yes The wall can remain unchanged, but 
by necessity due to high level in the 
river protection can be added.  

Structural Conveyance  Channel deepening or 
widening 

No River is quite wide at this location. 
Any adjustments to channel profile 
would affect weir hydraulics. 

Structural Conveyance  River restoration and/or pinch 
point improvements (bridges, 
culverts and weirs) 

No The weir is in good condition with 
recent work undertaken to add 
energy dissipating boulders. The 
efficiency of the weir is also not 
judged as a reason of the flooding.   

Flood storage area  Online  Use of active structures and 
re-profiling to store water 
online.  

No A large scale FSA system was 
considered in the Upper Aire SFRA 
and would reduce flood levels at 
Hirst Mill. 
However this is a large-scale 



 

IMNE790567-CH2-FEV-HM0-AS-C-0001 Page 10 

Category Long List Option Water 
Course / 
Areas 
Affected 

Description Take Forward for 
assessment? 

Reasoning / Notes / Past Study 
Reference 

scheme that will have significant 
impacts beyond the Hirst Mill area 
and is considered to be outside of 
the scope of this appraisal. 
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1.4.1 Shortlisted Options Description 
The options below were chosen to be taken forward for assessment in the initial assessment 

 

Do Nothing  

The Do Nothing option is defined as taking no action whatsoever; under this option all 
management activities would cease, including maintenance and repair work to existing assets.  

There could be some advantages of this option in the form of habitat creation due to wetting of 
dry areas and naturalisation of channel, however, this is also likely to increase the risk for the 
urbanized areas. 

The Do Nothing option is not to be taken forward as a viable option as it results in an 
unacceptable increase in flood risk to people and property due to failure and deterioration of 
assets and blockages to the channel.     

Do Minimum 

The Do Minimum option is defined as the minimum level of action or intervention necessary to 
sustain the standard of service (SOS) presently offered throughout the study area. It will form the 
appraisal baseline.  

This option assumes continuation of the existing maintenance regime. This includes maintenance 
requirements for existing structures and assets, channel maintenance, operation and 
maintenance of weirs and other in-channel structures and where possible, existing non-structural 
measures such as flood forecasting and flood warning.  

Initially the Do Minimum option will sustain current standard of protection to properties within the 
study area and there are no increase in costs associated with this option. However fluvial flood 
risk will increase over time due to climate change.   

There are no indicators to suggest that this option is non-viable or undeliverable.    

Option 1: Property Level Protection  

This option is to offer property level protection (PLP) to the 3 ground floor properties in the Very 
Significant risk band. PLP can take the form of barriers in doorways, non-return valves fitted to 
drains, and airbrick/vent covers. Properties can also be made more flood resilient, using 
waterproof plaster, solid concrete floors or tiled floor coverings in order to reduce the amount of 
time and money needed to recover from a flood event. PLP is generally used as an option for 
properties that experience less than 500mm of flooding. 

Advantages of this option include the fact that defences have minimal visual and land impact, and 
do not remove any of the flood plain area. PLP will protect against surface water as well as fluvial 
flooding. Any changes would need to be in keeping with surroundings. 

Disadvantages of this option include the requirement for residents to receive sufficient alert and 
for them to be available and educated in deploying PLP measures. Furthermore, PLP does not 
provide any wider environmental benefits and does not prevent the flooding of areas surrounding 
the property. PLP is also only possible for properties in the Very Significant risk bank (based on 
NaFRA), and where flooding is less than 500mm deep. The effectiveness of PLP reduces with 
long duration floods due to seepage. Deliverability of this option is reliant on the residents up take 
of PLP. 
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Option 2: Flood wall 

This option consists of replacing the existing wall which consists of stone columns with railings 
between,  with a continuous wall.  

Evidence from residents states that the level of the water during the Boxing Day 2015 event was 
0.5 m above the base of the railings in  the existing wall. A return period of 80-100 years has 
been estimated for the flow in the River Aire during the Boxing Day event.Therfore for  a SOP of 
100 years, it is  assumed that the height of the wall from the base of the railings would have to 
increase  by 0.5m plus an allowance for freeboard.  

. However, following confirmation of the required standard of protection, and subsequent 
modelling, the exact height may be above this level. 

The wall could be constructed from reinforced concrete, brick, stone or timber and cladding may 
be required in order to match the other elements of the house. There are approximately 10 
sections to cover between the columns, each approximately 2m in length. 

Option 3: Temporary defences 

In order to maintain the current visual appearance of the property, customised temporary 
defences could be utilised and installed when required. These defences may consist of 
aluminium or timber stop logs, and would be put in place by sliding them into specific grooves 
cast into the existing columns. Other options are also available and can be considered during the 
detailed appraisal. 

There are approximately 10 sections to be covered between the columns, each approximately 
2m in length, and as for option 2 the temporary defences would need to be 0.5m high plus an 
allowance for freeboardThe material should be as light as possible to allow the residents to 
manage it easily and quickly. A flood warning should also be issued giving enough time to the 
residents to put in place the devices. 

 

1.4.2 Costs of options 
 

The costs for the options were calculated using the Environment Agency’s Project Cost Tool and 
Long Term Costing Workbook. The maintenance and operation costs relate to mechanical 
maintenance of the assets to Target Condition 3. 

It is assumed that a major replacement of assets will be required at some point during the 
appraisal period after the initial construction phase. The timing of these replacements is based on 
the EA’s Asset Deterioration Guidance (2013), an appraisal period of 100 years has been used 
and the assumptions are outlined in Appendix B. Table 1.2 shows the initial cost and annual 
maintenance costs of the option and is assumed that a major replacement of the assets will be 
required at some point during the appraisal period. 

Table 1.2 Project costs (£k) 

Item Do Minimum Option 1 Option 2 Option 3 
Construction 
Costs 

 
26 22* 81 

Environment 
Agency staff 

 
4 3 13 

Consultant fees 
(appraisal) 

 
2* 1* 5* 
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Item Do Minimum Option 1 Option 2 Option 3 
Consultant fees 
(design) 

 
6 5* 17 

Consultant fees 
(construction) 

 
2* 1* 5* 

Site investigation 
& survey 

 
0.1* 0.1* 0.1* 

Land purchase  0.1 0.0 0.0 

Optimism Bias 
(44%) 

 
17 14 53 

TOTAL  57 47 174 

Annual Operation 
and Maintenance 
Costs (including 
optimism bias) 

0.5 0.5 0.5 0.5 

*Cost seem low for some of the activities but it is expected that these activities would be part of a 
package of work; eg ground investigation for several sites, so adjustments to the costs have not 
been made, and also there is an optimism bias of 44%. The above costs are just for Hirst Mill. 

 

 

1.5 Initial environmental assessment 

Table 1.3 Key environmental impacts, mitigation and opportunities 

Key positive impacts Key negative impacts Mitigation/ enhancement 
opportunity 

Option 1 

-Reduced risk of fluvial 
flooding, 

-Low risk of pollution incidents 
and disruption to area during 
construction. 

-Low aesthetic effect 

Option only protects properties 
and not surrounding land. 

 
 

Option 2    

Reduced risk of flooding 

-Construction work takes place 
alongside watercourse. Risk of 
pollution incidents and disruption 
to area during construction 

-Aesthetic impact 

-Best practice should be followed 
including referring to EA Pollution 
Prevention Guidance 

-Upholstery by stone 

Option 3    

-Reduced risk of flooding 

-Low aesthetic effect 

Construction work takes place 
alongside watercourse. Risk of 
pollution incidents and disruption 
to area during construction 

Best practice should be followed 
including referring to EA Pollution 
Prevention Guidance 

 

1.6 Consultation 

 

The options in this appraisal were developed in consultation with the Environment Agency and 
Bradford MDC. No public consultations were held at this stage as the work is a high-level 
assessment of potential options. Stakeholder engagement will take place at subsequent stages of 
the project. 
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If this project is taken forward for further appraisal it is recommended that consultation is focused 
on, but not limited to, the following: 

• Residents in the area at risk 

• Riparian landowners, especially owners of riverside walls acting as informal defences. 

 

1.7 Economic summary and preliminary preferred opti on 

Table 1.4 summarises the economic assessment carried out for all options. The calculations for 
PV benefits area shown in Appendix D. The options are ordered by benefit (lowest benefit first). 

The benefit values are estimates based on the methodology detailed in Appendix C. There is 
significant uncertainty in these estimates, which are based on Weighted Annual Average Data 
(WAAD) from the Multi-Coloured Manual (MCM, 2015/16). If this project progresses to further 
appraisal the benefits of these options should be more accurately assessed though hydraulic 
modelling and use of the more detailed flood depth / damage data from MCM.  

 

Table 1.4 Benefit-cost assessment  

 PV costs  

(£k) 

PV 
benefits 

(£k) 

Av. 
BCR 

Incr’ 
BCR 

Option for iBCR 
calc  

Comments 

Do Nothing        

Do 
Minimum 16 5 0.3 

 
 

 

Option 1 87 179 2.1 2.5 Do Minimum  

Option 2 67 179 2.7 3.4 Do Minimum Highest ABCR 

Option 3 236 179 0.8 0.8 Do Minimum  

 

1.7.1 Funding and contributions 

Preliminary estimates for Partnership Funding scores for Options 2 has been calculated as 
shown in Table 1.5.   

Table 1.5 FDGiA Funding Calculator 
Contributions to outcome measures  Option 2 

OM1 – Economic Benefit:   

    Benefit period used for Partnership Funding 
calcs 69 

    PV Benefits (£k) 165,306 

    PV Costs (£k) 62,135 

    Benefit/Cost ratio 2.7 

OM2 – No. of households moved out of any 
flood probability category to a lower category 

3 

OM2b – No. of households for which the 
probability of flooding or coastal erosion is 
reduced from the very significant or significant 
category to the moderate or low category 

0 

OM2c – No. of households in the 20% most 
deprived areas moved from the very 
significant or significant flood probability 

3 
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. Other potential funding sources identified include: 

• Community Infrastructure Levy 

• Benefitting local businesses 

• Council Tax 

• Local Enterprise Partnerships 

 
1.7.2 Key delivery risks (economic, social and envi ronmental) 
Key delivery risk and recommendations for mitigating these risks are shown in the table below. 
 
Table 1.6 Risks and mitigation  
Risk Key Mitigation 

Insufficient 3rd party Funding available to allow 
scheme to progress. 

Assess potential funding options before 
progressing scheme appraisal further. 

Risk of reducing the aesthetics of buildings (PLP) When considering resistance measures keep 
in mind their impact on aesthetics of buildings 
(PLP) 

Inaccurate benefits assessment due to limited 
understanding of flood risk hence unreliable 
approach to economic damage calculations used for 
IA’s. 

A more accurate damages assessment based 
on hydraulic modelling and flood depth 
damage data should be considered before 
progressing to further appraisal. 

Accuracy of costs A more refined and detailed cost estimate 
should be completed in conjunction with the 
benefits review.   

 

1.8 Project Scoring 

The data used in this assessment has been subjected to a RAG assessment. This gives a three 
figure score with the first number being the number of reds, where there is significant uncertainty 
or challenges. The second and third numbers are the numbers of amber(defined as needs 
development, but is manageable) and greens(well defined, not likely to be an issue) respectively. 
The results are shown below: 

• A – Problem Definition:  The flooding mechanisms are simple and well defined – 
GREEN 

• B – Economic Case: The benefits assessment has been based on moving properties 
from flood risk bands and weighted average annual damages – RED 

• C – Funding:  The options are likely to require external funding.  Work will be needed 
to obtain founding but there are opportunities – AMBER  

category to the moderate or low category  

Partnership Funding (PF) Score  54% 

Contributions required for a PF score of 100% £28,735 

Contributions required for a PF score of 120% £34,301 
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• D – Engineering case:  Solutions taken to outline design are common defence options, 
no particular issues are expected – GREEN 
 

• E – Permissions & Consents:  Solutions are unlikely to require unusual permissions or 
consents, but permission for third party properties is required  – AMBER  
 

• F – Environmental sensitivities: Initial environmental assessments has been 
completed based on outline options – GREEN 

• G – Opportunities: Some potential opportunities for partnership working but minimal 
environment opportunities – AMBER  

 

Model. 

A 

Econ. 

B 

Funding 

C 

Eng. 

D 

Permission  

E 

Env. 

F 

RAG Opps. 

G 
1 3 2 1 2 1 123 2 

 

1.9 Further work requirements 

If the project is taken forward for further appraisal it is recommended that the following work is 
carried out: 

• A more accurate damages assessment based on hydraulic modelling and flood depth 
damage data should be considered before progressing to further appraisal. 

Table 1.7 outlines key dates if these option move forward for further appraisal. 

 
 
 

1.10 Conclusions and Recommendation 

The main risk of flooding within Hirst Mill is fluvial from the overtopping of river banks, the existing 
flood risk is moderate to high.  There was significant flooding in the area during Boxing Day 2015 
from the River Aire. Option 2, raising the existing flood wall provides the highest ABCR.  The 
option is eligible for 54% of the costs being funded by FDGiA funding. 
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